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B TMS320C55x DSP CPU Programmer's Reference Supplement (Rev. C)
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F—~F X

1.1 R
O K TMS320VC5509A 200MHz
& J LAk
SRAM: 128K X 16 fif
ROM: 32K X 16 fif
& AN

@20 1 B 23 2 %

@ McBSP: 3 iHIE

& MMC/SD #1: 2 WIE

@ ADC: 2 WiE, 1017, 21.5kHz, 0~3.3V
@ SN IR RTC

L ZEAmELERE

SIIC 4

&4 SDRAM, RiE h 4M X 16 i

& 7N MMC/SD 411

@ AC97 brHEN) Audio 4L H

@ /M USB2.0 43% USB M #:11

@ /N 10M LUK M % 11

@ 11 CPLD il (¥ 42 4

@ (1 VC5509 ] GPIO ¥KZ)iff) 8 > LED 74T

L S lUPSEE %/

1.2 ik

FES FH LT HX-5509A FERMGE 2% 2] Pl TI ) TMS320VC5509A TfiFF K1), +
S PIHRy: AEATAAORURE L A A

7R HL T HX-5509A FF &R 4% T DSP. SDRAM. Codec. USB. MMC/SD.
Ethernet 2542 M /NS LUK TP 7 (1) DSP i 8y i o SRR EL R0 R A1 b HE R e
ORI

L PR A . -
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CPU [ 14555

LED ¥ 5547 SE56

CPU Timer & I #3525
SN IR A S

P& SDRAM 325 5256
¥ FLASH 125525
GENERE TN s

PO TN M s
AIC23 #5525

LCD /R 525

R A S50

USB2.0 1815 SE4

W) 4% 1017 S5

MMC/SD Kl {5 9256

1.3 BiAREIR

FACFEZE: TMS320VC5509A, E45 200MHz
SDRAM: 4M X 16 {7, 72MHz

Codec: XFHIE. SMAKFHIN/AH, i K AE2R 96kHz
USB: 74 USBL.1 #lE, #5mid gk 12Mb/s

TAERSE: 0°C~70°C
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F =% TMS320VC5509A FrH IR <3
2.1 TMS320VC5509

AR 16 f75E 15 DSP
e E 4. 200MHz
it 1.6V WAZ, 3.3VI/O

Gk MEPhER CREFe A 20 )

2.2 B8

VC5509A A A FMEIN A -

RGN B 4 CPU v WA BRI 5 5

SERFIF R O RTC 3R EME S, AT RGelr b o i b it o T A

KW B 2 (TMS320VC5509A Data Sheet).

2.2.1 RGm

VC5509 Pk i, A8 ARG s I, MBSk RS D SMHZ -~

20MHZ; fiff AN B AN, 71 X2/CLKIN I, i X1 &4,

Rg
Crystal
fif
c1 cz2
T T

FREQUENCY RANGE (MHz) MAX ESR (0) TYP C_gap (pF) MAX CgyunT (PF) Rg (Q)
20-15 20 10 7 o
15=12 30 16 7 o
12-10 40 16 7 100
10-8 80 18 7 470
8-5 80 16 7 1.5k
6-5 80 18 7 2.2k

HIF VCS509 P USB #2175 45— 48MHZ IR BRI, BRI 74572 I iy A sk it
PRI 48 IA5H IXFEE T DPLL AJ ASEBL 48MHZ I By 45 USB AiH] .

ARIFRACK 12MHZ S ) R G386 L3EAT 12 455572 2E 144MHZ CPU F i
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B, 4 £5557 42 USB Tt 48MHZ I 4l

VC5509 PEA S — MU BIAIER (DPLL), ‘&) LUl i i ol 25 4748 CLKMD ()
PLL ENABLE {7 A fig 545 H]

OO 24 PLL AR, b Hh mT DA A I B N SO IR 0 SR DY 43 A XA
TAETT AT AR AR TG

OO 4 PLL AERERS, X% I BIEA T I8 2 5 S E o A0, 79t T LASRASHA] B (10 B b %2
fintl. {A¥E PLL ENABLE {7, JfH2 bR L& 45N, V5509 dE A8
o

HOF B AR R R

N T VC5509 B AU TAERD LA SRR (A-E). I BB 9 A7 25
CLKMD #8235 N RA R AN, 4 CLKMD f#f¢ PLL, SUAHIIFEMN A REFFUH, 4
Z51EPLL I, W88 E DOARAS.

ACBIURPRAS . WP RIOR A AN B PLL RAS . SERTHIRE 5 DA MG S L&t
SEBM; b 2 B PLL DIV 5 PLL MULT PR ERSE . I35 35 A CLKMD,
ATLABEN T — B R, BIEA B RS

B: BiUHIRA. Wik CLKMD 5774511 0B {720 1, BifHE RS . #EA CARE&; W
R I0B J 0, WIHEA AGRZ, EHHATHUE.

C: 2SR . W IDLE ARASFFEAE, IDLE 54 ] LUK I 40 % - 2% B ) IDLE AR74&. 4
I = A 25 IE A IDLE SR AR I, IRl A= 25 505 8

D: PLL #2%1l, WHEp4it th BYPASS DIV fik#ziil, i@id’S CLKMD AJ LAk i
RAEZRPIRAS

E: ZSWPRZA O PLL 25 1R AHED
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DEP resat

Lol e |

h J
PLL disabled Laad CLEMD FLL enabled
with a new valus

F 1
h 3

Write o
CLEMD

Write 1o

D CLKMD

Lack ngy tha phasa

Bypass mode (bypass mode)

Idle mode
Fhase locked

entarac
Idle moda Phasa lock
axitad ot and Wifrite o
E 106 = 1 B CLKMD

Idle modsa Lock moda

Idle mode
entered

Il mcde
exitad

FYGEI Bia ] 75 474 CLKMD (3 ] 4n R -

CLKMD Bit Field(s)  Role In The Lock Mode

PLL ENABLE Allows you to switch to the bypass mode (disable the PLL)

PLL MULT and Determine how the input clock frequency is modified (if at all)

PLL DIV to produce the output clock frequency

1Al Determines whether the PLL returns to the beginning of the
phase-locking sequence when the clock generator exits its
idle mode

BREAKLM Indicates when the phase lock has been broken

10B Determines whether the PLL will reacquire a lost phase lock

LOCK Is 1 in the lock mode

ZEi et 5 A% K CLKOUT R F -



T

Ta CPU, peripherals, ather modules

CLKDIV i &R

CLKDIV  Frequency of CLKOUT

D00b
D01b
010b
011
100b
101b
110b
111b

1/1 x CPU clock frequency
1/2 = CPU clock frequency
1/3 = CPU clock frequency
1/4 x CPU clock frequency
1/5 x CPU clock frequency
1/6 x CPU clock frequency
177 = CPU clock frequency

1/8 x CPU clock frequency

2.2.2 RTC 4l

RTC 352 32.768KHZ [1) fiAAi% 4 3] RTCINX1 5 RTCINX2 M N B F o 2548 H &

PREm NI, B eh A% RTCINX |, 1ff RTCINX2 &%,

i, RTCINX2 &%, nJ KBS
ATFRMCK 32.768KHZ fiik 4 RTC 34t 4 S, HARESA R .

RTCINXA

RTCINX2

Crystal
32.768 kHz
m
I[II
c1 I c2

i

http:/www.mcuhx.com TEL:028-84779619 QQ:601105013
CLEDINV
CPU clock . CLEOUT
D3P dlock generator H - To CLKOUT pin

2 IhAEAR N, RTCINXI
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2.3 AN
VC5509A SCHPGE— 4k A=), (HH PGE 5 GHH Pt e s ) 1) 2 1a) 2
AR, XA B GHH BT 21 Mthikk, FrblUe R ok i e v il 10 525 25 0]
IM X 16 7, 11 PGE 21 AT 14 Ak 2k, Jr LUE RS e i BE VT 1) 1 58 47 0] 2 8K X

16 177,
2.3.1 F bAoAtk
32K X 16 A7 5. AV i) DRAM, FEF/AdsmIvil, 45k 8 B, RN A 4K X 16

96K X 16 1/ 5. AV i) SRAM, FEf/Au a3 nlviin), 434 24 B, RPN K 4K X 16

32K X 16 {7 1 JiI5E4F ROM, C.4[# 1L T BootLoader #2)7, M1 51T, H/ kL

YA
2.3.2 FAMEEAE ]

JrANEAE S 1] )il it EMIF (External Memory Interface) #115K5¢H, VC5509A
FAME 4 AR R 4 NRIEES), SCRIFEAR I 70 SRAM. FLASH #iI
SDRAM. *i>KH SDRAM I, e Ku[ Vi) 8M X 16 A7 (roh 4 AN ik
$< SRAM. FLASH Itf, PGE H[$¢ R Jr ik {5 5 vl Ui i) i3 18]k 8K X 16 7, 4Lk 32K X 16
fr; GHH BEEAFIEE S vl Ui i3 2 IM X 16 £7, B34 4M X 16 7.

KT EMIF BITEAN 69, 2[4 (TMS320VC5509 DSP External Memory Interface (EMIF)
Reference Guide).

T4 PGE B8 A R 0 Be . (L ¢ TMS320VC5509A Data Sheet))
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Byte Address
(Hex)t Memory Blocks Block Size
000000
MMR (Reserved)
oo fF——————————————
DARAM / HPI Access (32K - 192) Bytes
008000
DARAME 32K Bytes
010000
SARAMS 192K Bytes
040000
16K Bytes - Asynchronous
1-TED
S 4M Bytes - 256K Bytes SDRAM?
400000
Externall - CET 16K Bytes - Asynchronous
4M Bytes - SDRAM
800000
S 16K Bytes - Asynchronous
1-
Externall - CE2 4M Bytes - SDRAM
Cco0000
16K Bytes - Asynchronous
Externall - CE3 4M Bytes - SDRAM (MPNMG = 1)
FF0000 4M Bytes - 64K Bytes if internal ROM selected (MPNMC = 0)
ROMII ExternalT - TE3 39K Bytes
(if MPNMC=0) |  (if MPNMC=1) y
FF8000
RoMIl Externall - TE3
(if MPNMC=0) | (it MPNMC=1) | 16K Bytes
FFC000 sronl
(if SROM=0 & | ExternalT-TE3 | 46 Bytes

B TMS320VC5509A FFRARAM™— 7 16 711 SDRAM, HI/CEO itifl, #ih 4MX
16 £z, Stk FH/CEO F/CEL WAt 7S 1] KT LE ly 8M*16 7, Al CE0—CE3 4
AP Fr A7 At )

J1ik CEO---CE3 5| & M eky e as b, B AATHERB .
2.4 1458 HPI 5 GPIOA

#£ VC5509 DSP ' EMIF. EHPI fll GPIOA 28R H A. C AEMIK. Nz E
A7 GPIOO B AR A 5 A i £k 1% %% EBSR (External Bus Selection Register) [] Parallel
Port Mode fi 3Ky sE . HEHOCR TR :
O fES A
1 GPIOO Jyift, A 2 EMIF fhihb4irit, C 24 EMIF Bl gk
24 GPIOO MK, A 4 HPI sttt iy, C o4 HIP fF il s 2 i s
AT RBGE IS BEE 12 %7 GPIOO0 5 JAIREAT LR A ™4z,  LASEIAN A RC &

O E8467 )5 Hik$F 2 H EBSR [ Parallel Port Mode 17 ¢ 5&
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24 Parallel Port Mode =00 H+:

Hlls EMIF 775, D h3diegk, C 4 EMIF %l Zk: A i GPIO;
24 Parallel Port Mode =01 H+:

42 EMIF J5 3K, D Wi B4k, C 24 EMIF [l Lk; A 2 EMIF [ HhEr
24 Parallel Port Mode = 10

5 HPI 775, D AEdlE ALk, C M—&5 A HPL M#shlag, —Hah
GPIO; Ak HPI [ btk 5

24 Parallel Port Mode = 11 Ii¥]:

SR HPL 530, D W R4, C W&k HPI B4EHl R4, —#80 N
GPIO; A & GPIO;
Eva Ay Ny ,—‘:» . . N N
AR L 2 1%k $F 27 A7 %% EBSR(External Bus Selection Register) P4l Ui B U T
16 14 13 12 11 10 ] ]
C[;'-KOUT QSC Disable HIDL BKE SR STAT HOLD HOLDA CKE SEL
isable
RW, 0 R/W, 0 RW, 0 RIW, 0 RIW, 0 RW, 0 RW, 1 RW, 0
T ] ] 4 3 2 1 1]
Serial Port2 Serial Port1 Parallel Port
 — SRCMD Mode Mode Mode
RIW, 01 if GPIOD = 1
RIW, 0 RIW, 0 RIW, 00 RIW, 00 1 i GPIOD=0
BITS DESCRIPTION
CLKOUT disable.
15
CLKOUT disable = O: CLKOUT enabled
CLKOUT disable = 1: CLKOUT disabled
Oscillator disable. Works with IDLE instruction to put the clock generation domain into IDLE mode.
14
OSC disable = 0 Oscillator enabled
OSC disable = 1: Oscillator disabled
Host mode idle bit. (Applicable only if the parallel bus is configured as EHPL)
When the parallel bus is set to EHPI mode, the clock domain is not allowed to go to idle, so a host processor can
access the DSP internal memory. The HIDL bit works around this restriction and allows the DSF to idle the clock
domain and the EHPI. When the clock domain is inidle, 2 host processor will not be able to access the DSP
13 mEmory.

HIDL = 0: Host access to DSP enabled. Idiing EHPI and clock domain is not allowed.

HIDL = 1: |dles the HPI and the clock domain upon execution of the |DLE instruction when the parallel
port mode is setto 10 or 11 selecting HPl mode. In addition, bit 4 of the ldle Control Register
must be setto 1 prior to the execution of the IDLE instruction.

Bus keeper enable.T
L BEE = Bus keeper, pullups/pulldowns ensbled
BRE = 1: Bus keeper, pullups/pulldowns disabled




T
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BITS DESCRIPTION
SDRAM seikrairesh status bit
"
SR STAT = 0: SDRAM salthrafeth signal it not asteried
SR ETAT = 1: SDRAM salhrafeth signal it stderad
EMIF hald
10 HOLD w DEP drivad Ta axtermal mérmary bus
HOLD w 1: Rlequest fie exiemal memary bus i be plassd in Fghimpedanscs sa S anafer devies can
cirinve
EMIF hald acinaadad ge
HOLDA= X DEPindicates Fial 4 had request an the ecdemal mamary but hat asouned, Fie EMIF
3 sarmpheted any panding & xiermal bus asfhvity, and placedt v:.!.“-'m rérmnary Bus Signals in
3 mpedance stale address bus, jaa s, TE[EA], ADE, AiWE, BRE, SORAS, 5OCAS,
SOATD, CLAOMEM). Ones 7 b1 caared, an exiemal devies can dive e bus
HOLDA= 1: '\.- hald asknoaladge
SDRAM CKE pin sslasfion Bt
]
- : Use XF for SDRAM CKE signa
: Use GPI04 for SDRAM CKE signa
SDRAM CKE anable bit
7 CKEEN = D: XMFar GPID.4 aparates in narmal rmade
CKEEN=1: [Basaed on the CKE SEL b, ather XF or GPID 4 drives the SDRAM CKE pin
SDRAM seiknafresh cammand
S
- FCOMD = @ EMIF will natissue s SDRAM sethrafresh command
S CMD = 1: EMIF will isaue 8 SDHEAM sakrafath samnmand
Sarial part2 mada. MeBSP2 or MMC/SD2 Made. Detarminas e made of Sarial Part2
fes Serial Part2 Mada = 00 MeBSP2 made. The MeBSP2 signals ane routed fa Setix ping of Seral Part2.
- Serial Part2 Madew 01: MMCISD2 made. The MMC/S02 signals ane rauted faihe six pird of Seral Part
Serial Par2 Madew 10:  Restarvad
Sarial Pori2 Mada= 11 Reservad
Sarial part] made. MeBSP 1 or MMC/SD1 Made. Datermings the mode of Serial Partl
33 Sarial Part! Madew 00 MeBSP1 rmode. The MeBSP1 signais ane routed o $e tix ping of Seral Partl.
- Sarigl Partl Madaw 01: MMCISD made. The MMCISD1 signals are rauted ta ihe tix pird of Seral Part1.
Sarial Partl Madaw 10: 45#-.“-:1
Sarial Partl Madaw 11:  Rédarvad
Parallsl pard made. EMIFHPEGPID Made. Datermines e made of $ia paralsl parl
Paralbal Port Modew 00: Data EMIF maode. The 18 EMIF data sigrals and 13 EMIF carfral signais ane
muted faihe carmespanding exiernal parallel bus dats and canfral signais. The
14 {LOFF) or 18 {BGEA) address bus signals can be used 83 general-purpase 0
arily.
Paralbal Port Modew 01: Full EMIF made. The 14 (LOFP) o 21 (BEA] addrets signals, 18 data signals, and
15 aantral signais ane rauiad ta the sarmespanding extermal paralel bus addnes,
1= data, &nd sariral Signals
- Parallal Part Madew 10 Marwrmulfipesd HP | mada. The HP 4 enstded anits 14 address aignals,
18 dafta sagnais, and 7 son fral aignals ane rauted o he arredpanding addrasa,
data, cartral sigrals of $he external paralsl bus. Mareaver, B sanfral tignals of $ie
encterrial paraibal bus ane uted A8 gensral.purpats |50
Paralbsl Port Modew 11: Mulipiexed HP| made. The HP| s &nabied andits 18 data sigrials and
10 sonfral signals are rouiad ta the exdernal paralbel bus. In addifan, 3 confra
aigriala af $he éodernal paralsl bus sre uded B8 gensrapurpads |10, Tha
14 {LOFP) ar 18 (BGA) extermal paralsl part addrans but dign sis are ubed s
el gurp ada 110

PEAIUL I ZF S0 (TMS320VC5509 DSP Host Port Interface(HPI) Reference Guide

(SPRU619)) 1 (TMS320VC5509 Data Sheet (SPRS163))

2.5 RARAE P M
251 RAEAL

RGN, M EHE] DSP i 247, — 852 30ns+3 > CLOCKOUT

(ot o vk I AL B EIN Ehr AR L AR
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X2ICLKIN

A VAVAWAVANVAVANS

R3

ﬁ
CLKOUT ) . )[_\ /_\_/m
4 .llr

I
;
DVop SRS . ] ]
Hrf R3 5A00 30ns, R2 25 3 4~ CLKOUTS,
AIF Rt BB, BT Z AL fE.
252
VC5509 — 347 5 AMAMERHE, O INT[0—4]. FH IR P F

CVWpp=1.2V CVpp =16V
NO. UNIT
MIN  MAX MIN  MAX
bl tagINTLJA Fulse width, interrupt low, CFU active r r ns
12 tagINTH)A Pulse width, interrupt high, CPU active P P ns

T F = 1/CPU clock frequency in ns. For example, when running parts at 200 MHz, use P = & ns.

XX R X 0 A X

RS IEIN

KT AL B i, VC5509 Jl I DL T () A A7 a5 B kT

Register(s) Function

NVPD Points to interrupt vectors 0-15 and 24-31
IVPH Points to interrupt vectors 16-23

IFRQ, IFR1 Indicate which maskable interrupts have

been requested

IERO, IER1 Enable or disable maskable interrupts

DBIERD, Configure select maskable interrupts as

DBIER1 time-critical interrupts during debugging
o

IVPD 5 IVPH J& T N L AL 254728, WAt e VC5509 F 8T ) 1 42 AT DL EE BT
ENLI o

IFRO. IFR1 & WRR S T4 8%
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IERO. IERI 2" I fdi G 37 47 2%

DBIERO.DBIER 1 /& A 72 75 1R I A 7544 7 e 167 D47 DAy s ] e e v b A 2

FEVCE 55 1B 50 I 7 I Y R

FEAE S T ) B R 27 A2 4% IVPD 5 IVPH 20T, W& INTM 4 1, BHIEAMKR I R
P

XFANRTBER T, B IS i B3R, SROMEAE S SO, A ATk
(REER SR U

Hh T ) SR ) 2R R 3R
Vector Address
Vector(s) Interrupt(s) Bits 23-8 Bits 7-3 Bits 2-0
O Resal IVPD 00000 a0
11 Monmaskable hardware VP 000071 a0
interrupt, NI
VZ2-IV15 Maskable interrupts VFLD 00010 000
o
011N
WM16-1V23  Maskable internupts IVPH 10000 000
b
10111
[v24 Bus error interrupl (meask- VPR 11000 Qa0
able), BERRINT
V23 Data log intermupt {mask- IVFL 1100 a0
able), DLOGINT
IV2s Real-time cperating sys- VP 11010 000
e interrupl (maskable),
RTOSINT
W27-IV31  General-purpose soft- VFD 11011 000
ware-only interrupts to
INT27-INT31 M1

. PR IIE S B R (TMS320VC55x DSP CPU Reference Guide (DPRU371))

2.6 VC5509 Bootloader

VC5509 [1] Bootloader & 3tAH /SF 7=, Wk
W #ik EHPI ¥ bootloader, fEIXFH =T, &HIYE HPI fHE& H P HPI ¥n],
B ik EMIF 45 2 A7l 4% Bootloader

McBSPO # 1 Bootloader, 3Z#F 8 75 16 fi /5.

a

T

L IBlibON

McBSP0 #:4T EEPROM Bootloader, ¥ 16 fi755 24 £ J5 =,

W i USB Bootloader
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B I Bootloader, EL#2M i 4h FLASH LHUTFET

Bootloader 5|5 /7 UL S 2L GPIO[0--314E E AL PR SR 58 bt . HA i ~

*:
GPIOD GPIOZ GPIO2 GPIOT BOOT MODE PROCESS
i} L] 1} a Reserved
4] 0 Ll 1 Serial (SP1) EPROM Boot [24-bit address) via McBSPO
Q a 1 0 UEB
i} a 1 1 Resarved
0 1 [} a Reserved
u] 1 Q 1 HPFl — multiplexed mode
4] 1 1 0 HPI = nonmultiplexed mede
[i] 1 1 1 Rasared
1 a a ] Execute from 18-bit-wide asynchrencus mamory (on CET space)
1 ] Q 1 Serial (SP1) EPROM Boot (16-bit address) via McBSPD
] 0 1 0 Reserved
1 a 1 1 18-0it asynchronous memany (o0 TE1 Space)
1 1 L] ] Resarned
1 1 1} 1 Reserved
1 1 1 0 Standard serial boot via McBSPO (16-bit data)
1 1 1 1 Standard senal oot via McBSPO (8-bit data)

ATFFRAR E GPIOO il ik Bk2k 12 Skik$ bhro F 4z, GPIO1 ik Bkek 13 Skik$f b 7ok
Nz, GPIO2 Jl ik Bkek T4 Skt $% bk N4z, GPIO3 Mk Bkek J5 skt £ bdrel N 4. ArLl,
ATFF R M) Bootloader /7 x0 Al DLl L 12, I3, J4 Fll J5 SRik#%.

W RIS S E R (TMS320VC5509/C5509A Bootloader (SPRA375)).

2.7 VC5509 B 5 _E4hik
2.7.1 ERER

VC5509 13 2 A~ 20 A7 138 F 2 IS A0 1 ANE T 1058 I 4%
TN BEITER LATE 22 0 (TMS320VC5509/5510 DSP Timers Reference Guide

(SPRU595)) .

2.7.2 DMA
VC5509 HAT /AN A 9w FE ) DMA i % o
DMA [f) V£ 404t W15 2 % S0 ( TMS320VC5509 Direct Memory ACCESS (DMA)

Controller Reference Guide (SPRU587A))
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2.7.3 USB1.1 #0

VC5509 Jr A —AFF4 USBLL1 bRifERIHE 1, {H 22 345 FULL-SPEED M J7 {0 —Fiit,
SCREIAL R AL

W A

W kAR

W [

TFF R R % LR B AR USB B 241 L

USB PEH 3 IIE 2 2% 0 (TMS320VC5509 DSP Universal Serial Bus(USB) Module

Reference Guide (SPRU596)) .

2.7.4 1IC B &
VC5509 b —AN T WA Al TIC, ATFFAEBCK 1IC HZ1Eh CODEC (14
il 1
IC V40 Ut W il 2 % SR ( TMS320VCS55x DSP 1IC Module Reference Guide

(SPRU146)).

2.7.5 SERTEM9P RTC
VC5509 LN & —ANSEIIN B RTC B, $RBEE. L HL I 2r . FhARSEF e
Boo ARIFEMCA VC5509 [¥) RTC Fid 32.768KHZ S iAVE AL, S8R HZE C5 11N
RTC (¥ /5 % HLAE . (EARTF R ARG, 4k4204 RTC $2AEHIR, DAARIE RTC ST 40 1E A -
RTC MIEAENIE S % 0k (TMS320VC5509 DSP Real-Time Clock(RTC) Reference

Guide (SPRU594)).

2.7.6 2 R 10 AL AD
PGE 12%%() VC5509 147 2 ANilliE (GHH 21447 4 NlIE). 10 A7 HER (1 AD £
PN . ATFRIRAH PGE 3421 VC5509, HKf AD [ i i R 4%+3.3V, (RIEHER &
e, PTLL 2 ISR RN 0 — 3.3v, 2 AR G| 2 ALY EERS 12 1,
P BATIEH .
AD [FPEANE S S 2% R (TMS320VC5509 DSP Analog-to-Digital Converter(ADC)

Reference Guide (SPRU586)) .
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2.7.7 McBSP fl MMC/SD #H
VC5509 J A 34 McBSP 2 1511 2 4~ MMC/SD #2111, 3 /1> McBSP 43 %l ) McBSPO,
McBSP1 #1 McBSP2, 2 4~ MMC/SD #125 MMC/SD1 #1 MMC/SD2.3LH McBSP1 &
MMC/SD1 £ HAMH 51, McBSP2 5 MMC/SD2 £ AN 5. McBSPO Hpl i F 718
S8

FEARTF R, McBSPO 540 ) CODEC 2% #F 1% M 8211, 528 CODEC % 1)
N/ . McBSP2/ MMC/SD2 Fit ' fit MMC/SD #2111, 5|2 MMC/SD #:4% I, DLV

5] 4R MMC/SD .
Ak McBSP Hl MMC/SD & HI ¥ 1F 41 Ui W] 1§ 2 % CkY ( TMS320VC55x DSP
Multichannel Buffer Serial Port(McBSP) Reference Guide (SPRU592)) Fl ( TMS320VC5509

DSP MultiMediaCard /SD Card Controller Reference Guide (SPRU593)) .

2.7.8 GPIO
VC5509 [ 8 ANl 1O % F 51 GPIOO — GPIO7, {F PGE #3411 VC5509 %1
GPIOS 51l ATFFEMCKE GPIOO — GPIO4. GPIO6. GPIO7 Al XF lit & kit , ik
“0” I, XN LED $R/RKT 4 it HE 555 LED SRR T 2 IR0 RO SR A R i

N

GPIOO0 GPIO1 GPIO2 GPIO3 GPIO4 GPIO6 GPIO7 XF

D12 DIl D10 D9 D8 D7 D6 D5




7%{%‘#33 5 http:/www.mcuhx.com TEL:028-84779619 QQ:601105013

F=%F s5b¥F SDRAM &8s

ATF Rt B CiEid VC5509 1) EMIF B4 i€ 77 SDRAM, fEFRHERCE R, R 2%
e 64AM AL (4M*16 £i2) 1) SDRAM, ¥4 ] VC5509 (#) CEO F1 CE1 W4 1 A F7 i 4
), Al FEFE Y 0x040000 — OX 7T F KRCEN, M bnlZee—h 128M £ (8M*16 i)
(1) SDRAM, ‘B4 Fil VC5509 ) CEO — CE3 AP J #M 7t = 1], 7] FH4ik3 Bk 0x040000
— OxfAFFMPNMC=1 It}), FHEALN, MPNMC #3% h 0. M4 VC5509 ) EMIF 4 1 %E
&, SDRAM HJTAEMIZ A CPU LMo —=F, T4t 144MHZ I, SDRAM K TAESH
A 72MHZ.

R4/ SDRAM Z i, VC5509 iE75 2% EMIF $HTRCE, HECE IR T

W WE A A7 EBSR, KAMEBE LB EMIF TAER

W % E517%% CEx, L4k SDRAM 2R/ BRI TERE . lHT 7 0%

B S KNP A {7 4% . £446 SDCI. SDPER. SDCNT. SDC2.

EMIF [AHOGHCE, — MR CLS P e it s B L (8. VR I DL S 6 18
J¢ EMIF 451 f%

A% EMIF #1740 Ui B 35 2% SCR (TMS320VC5509 DSP External Memory

Interface(EMIF) Reference Guide (SPRU670))
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FOE TFHWNESWH

ARIFRAAER TLV320AIC23B SEIL & i A\ S far i, TLV320AIC23B J&— 7 4l
CODEC ##F, EMHADIfetdE: 48KHZ 7755 96KHZ KAEA ., BUAHE LA AD. DA;
P S ST (BRAEENIDI RO, AEERAE 30mW it T, IKE) 32 Wi
FHO

TLV320AIC23B 5 ifab 345 4% LA PN, —AN i 1, Bl T & TLV320AIC23B
TS A8 1, HT16%1 TLV320AIC23B ] AD. DA %l .

VC5509 H 1IC 4k 115 TLV320AIC23B #iil % #:,  SEHGT TLV320A1C23B 4%
AW E . VC5509 i85 i AN McBSPO FCE 4 IS TAE 73, #:10 TLV320AIC23B

(oK 1, SIS AR P A A\

4.1 TLV320AIC23B

TLV320AIC23BC LA R i FR -l AIC23B ) T H ) — 3 itk e A SZ44 7 4l CODEC
O, WEHENUE S FRBOR, S2F MIC AILIN IN PR AT (ZiE—), JFHEARM
Kt L A AT TR 2594 Y - AIC23B REUE, e ADC ML DAC F v FEAR £
AR, SR T SEEER) Sigma-Delta RERFEECAR, WTLAE 8K 2 96K RAEFJEH AL 16
By 20 A7y 24 A7 F1 32 A RAE, ADC F1 DAC [AIfE e LE 43 51 v] £ 90dB Al 100dB.  [F]H,
AIC23B & ARG, FUSB IR 23mW, A BB T 150w,
AIC23B [ R P9 38 25 R RE J<l 4 T
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Avpn —1 vaOc
VAT DEPeodes
VRO TLWI20AICEIE
VMID
AGHD— + )
Control SOIM
Interface | SCLK
MICBIAS o
12 bo -34.5 48, + MODE
1.5 dB Siaps :
Line kol -4
RLMNEIN- :g T Mute - ML ADD .
FY
it Bypass  Wite,
S—— Mute g g, Zﬂ-dﬂ]
]
AN — . WwADE —
VMID -
241 -
LLINEIN e 1wl e ame * F—
Digital l— Bvon
12 & -34 @8, Side Tors Filbars
1.5 4B Steps Muts i DGND
HRVDD M yoogpnone 6 1o -7308, Bypass
HPGHD —™ Dirivar 1 dB Staps Mule
RHPOUT— pac [
-
N ]
Lot E— i
3
LHPOUT b L paC o
Hesdphone 6o 73 d8. E &
Diriwer 1dB Steps CLKIN
EEE— Divider
fix, U2xh Yy
b + LRECIN
HTUMGLE - > CLHOUT Digia1 |# DM
ase Divviclur P
L T
T [, 1] et | pay :;’gﬁ‘:"'
CLKOUT | + BCLK

4.2 TLV320AIC23B 523 O

TLV320AIC23B S5t #5188 A A, —AN24H] 10, HTE TLV320AIC23B

I LAESEG 59— A% 0, H F4&%r TLV320AIC23B [¥) AD. DA %i#.

AR VC5509 [ TIC M4 115 TLV320AIC23B #1343, McBSPO fit & b

IS TAER, ¥ TLV320AIC23B (IR 1.
4.2.1 AIC23B F¥i3E O
TLV320AIC23B s DA DA TAE 720, 4090 K

B Right justified

B Left justified

M IS Mode

B DSP Mode
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Forb S PRI RT LR 77 {8 b5 DSP ) MeBSP H: S . N IIFRAT LA DSP Mode #5X¢
WK PR . LR b (0 I I R

BCLK: #i#t FI7-IN8i{5 5. TLV320AIC23B A MAE (—efol), #Ziehth DSP
77 TLV320A1C23B J EAEAI, I il TLV320AIC23B 77/

LRCIN: i 11 DAC it 1 hd 7] 25 58 TS AT FR) 22/ 47 75 T I

LRCOUT: #ffs 1 ADC %y A\ FRifa] 20 5 1S AL (¥ 2 /47 P IE I

DIN: H#fs 1 DAC it i1 83 47 Eda g A\

DOUT: ##fi F ADC % NI R AT Edl 4

XIS LAA DSP ) McBSP JC48ER:, ME— ST R A7 2 McBSP FHEWCN S
AIC23B 1) BCLK #B 1 McBSP A& it 4 AIC23B 3 BE#% M, McBSP (A% Y
WO B8 Hr AIC23B Skffit. EROREEIAT:

CLKX :j—» BCLK
CLKR

FSX <a—— = LRCIN
McBSP FSR l«—» LRCOUT

‘AIC23B
s 1

DX » DIN
DR l¢«———m DOUT

DSP 5 AIC23B HJIEFEE AT LR ) DSP A2, Wn] LCRH] IS A=K, XX AE T DSP
(¥ McBSP WAl A5 5 (S8 R o J 3 RO ) 2545 5 1 B BE A0 — AN (16 ) K, TR
(T 5 P T LAk — MK, BEndE T 16 A (RIZEAT A IR A0 16 A1), Wikhy 32
FERINEOL T, AR IS, WilRl A5 5 S8 LN 16 A7, 1R DSP Mode Mifi 5 6/ 1 £

BT, DSP AU, AIC23B $dis C I e 40 R s
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LRCINS
LRCOUT
BCLK I I I I | I I
% -
Left Channel Right Channel
DIN? 1I 1o =1 1]0
i i
pouT
MsB LSE MSE LS8

McBSP [ 40 i B 3% 2 2% R ( TMS320VC55x DSP Multichannel Buffer Serial

Port(McBSP) Reference Guide (SPRU592))

4.2.2 AIC23B Hi3z#I 0
TLV320AIC23B [zl XA PR TAE 52, 205000 -
2 Zkflilfd) IC Jy =X
3 Zkilf¥) SPI By ik
VC5509 Jv L&A 1C Bk, FrAATF RRCERERA] VC5509 1) LC 52 RiE
TLV320AIC23B 14l 1. VC5509 Bt & 4y TIC [ E 1% 7%, TLV320AIC23B 47 1IC [ MK %,
VC5509 i 1IC &2k, % TLV320AIC23B #HTHLE .

TLV320AIC23B H o] it & (K42l 25 A7 2 i R R i

il HEYR LT TS
0000000 EFIEFEEEHEE S
0000001 AFENERENET S
0000010 EFEIEEHANZERSTF TS
0000011 HEIEHANEBEIT S
0000100 B ZENREENEFE
0000101 UFTHMRBRENETS
0000110 HEFAEHEESE
0000111 HETFMENBRATES
0001000 EHEMEEFTS
0001001 WFEENGEFER
0001111 Hr s

4.3 TLV320AIC23B fykElE: O
TLV320AIC23B [0 #2111 EZAHE LT PYAN 4
[ IR IUN

B MIC A
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[ AN TR
W HhlnH
4.3.1 SHHN
4.3.1.1 SEARFERIN
SEAR PN RS ZE AT IS, JLRE N -
LLINEIN: 7:/518 LINE IN i\
RLINEIN: 7738 LINE IN %\ ;
TEMERINEE S 6 .
MIC fig \
MIC i N\ 382 ORI I TE R 1) 22 v AT E A KR AR o L el T 22 e KUt TR
Jeas A, BT RAEE S H P s . S N T
MICBIAS: 244 5o X\ B i s, 8% /2 3/4 AVDD:
MICIN: Z2 e M, B AIC23B S5 HHE K AT DL HBORAR BRI 5 15 18
A O N E G TGS IR LA .
ARTFRMCRH 2 AFRUERT 3.5mm & e PR KRBT SZAR N (719) I 50 XU A.(J10)

432 HHifH

4.3.2.1 AR

TLV320AIC23B ittt 73 0 2 ¥, Horp—# N TE DR RS AL AR iy, Hofar 5|
b

LOUT: /&4t

ROUT: A /A1

4.3.2.2 HHlsH

TLV320AIC23B W& H AT R BONIR S e, LAE ROk Ml i HAL, A5 22400
FREATIRE) T HA AR .

LHPOUT: /& i HHUBOK i

RHPOUT: A5 A HA B i th

RIFRBERH 2 AFRUER 3.5mm #5454 e AR S P i R L

4.4 ErHEh

AIFRACER 12MHZ B 47{E 54 AIC23B 24 it MCLK, =i 4 MCLK 5%

FERZ M2 RIS E R (TLV320AIC23B Data Manual (SLWS106G))



7%{”%"}‘33 BT http:/www.mcuhx.com

TEL:028-84779619

QQ:601105013

BARFE

ATF RPN AFE A 20 A, 73502

CPU & M5

LED [l Sy AT S5

CPU Timer 5 [ #5555
LIS I RS AG

AD A5 5

¥ SDRAM 25 SEH

¥ J# FLASH 35 5256
PRAAG AT - AZ . (FFT) S 56
FIR 8 4 55 56

TR JEP A S5

HiG VR #s (FIRLMS) 546
A A4 S
CISHIE LT NS W
AIC23 # & 5L 5

LCD B/R5E5

R B A S5

USB2.0 3l {5 sE 5%

W0 £ 35 S5

MMC/SD K35 5L 5

W, ESHE G AU SRS .
JrEUR

AT 5

sl “CCS”, JH3) Code Composer Studio T & 455

A_E IR P A nT AAE BORIGERE AP R BTN A SO o IR, REAT . ) ST S5 DL
BIREEL B AR AN AT DO B PR 740, R R B m .
IR I AR IR B & 5L T AR A 7] TDS510 (7 ELA8 1. i Al H HAR R AL K 7

JITARET I OUT SCAFRT, 1858 Iz -9 R C€5509.GEL LA, LAwILatt 5509,
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rittilproject]-- [Open... T HA THE)S, 76 CCS M2 A VIEW HEH 47 [GEL
files). W1 NEIFTR:

# /CHH00 TDS510USE 2.0 Emulator/CPU_1 — TES320C55zx — Code Composer Studio

File Edit W¥iew Froject Debugz GEL Option Frofile Tools DSF/EINS Window Help
IR ER L L
det.p_it L”Debug L” @ Iﬁl | ‘{T_n] ﬂ . /&
Hié 0 EBRERHE-L

* | [Frites

=-£3 Fro
iy [

w AMlow Docking
Hide
ﬁ"' Float Im Main Window

P N hr bl Load GEL... Y, 7E 3 H RS UG AE HH o 0% TR H ¢ R I“C5509.GEL”,
wrEprR, i 49

Load GEL File

BHIEE @ | ) Ss09H0T ~| « @& ek EE-

Bﬂebug
[Cwdt. C5_

R GEL Jrig
{7 BER: 2003-5-6 14:37

Fuh 4,85 KB
MG W) 5509, gel 7 @
RARE icriv iT): IGeneral Extension Langunage Files 0. ;I A0

FERD (1)




7%{%‘#33 5 http:/www.mcuhx.com TEL:028-84779619 QQ:601105013

SR —. CPUFTHLR
XA T R IR 11805 I 2% AR IR R
AR, 2 PU N P BRIEAT
(1) il “cCS”, J33h Code Composer Studio JT & 35
(2) fiidi [project] > [Open...]1 #IFF “5509WDT” SCHFJE R “WDT.PIT”.
(3) Jn#k “5509WDT” 303 R “C5509.GEL” UM a7 i WA EE I Sk 8
(4) siidi [File] > [Load Program...), EH “5509WDT” (3 F ¥ “DEBUG”

i) “WDT.OUT” X, sidi [4T9F).

(5) fiili [Debug] = [Run] Sl P4 bt 3 Kkr, 4#isir. BInER] CCS
FJ5 “STDOUT” HeH, HBLET e 25 h s . W FEFR.

pscVal: b, wdter: 1Zef
pscWal: 6, wdtcr: 1Zcf
pscWVal: 6, wdter: 1lZcf
pscVal: b, wdter: 12cf
pscWal: 6, wdter: 12cf
pscWal: 6, wdtcr: 1Zcf
pscWVal: 6, wdter: 1lZcf
pscVal: b, wdter: 1Zef
pscWal: 6, wdter: 12cf
pscWal: 6, wdtcr: 1Zcf
pscWal: 6, wdter: lZcf
pscVal: b, wdter: 1Zef
pscWal: 6, wdter: 12cf
pscVal: b, wdtcr: 12cf
pscWal: 6, wdter: lZcf
[ 41> [ ]\ Messages p Stdout /
m @ HALTED For Help, press Fl

% .OUT XXfF)5, sidi [Debug] 2 [Go Main), #RJ5 s i [F10] 2k
ii [Debug] > [Step Over] LU IR AR 21T, BTG 2 NPT I1E S
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pscyal: 2, wdtcr: 10cf
pscyal: 4, wdtcr: 114f
pscyal: o, wdtcr: 134f
pscyal: 4, wdtcr: 114f
pscval: o, wdtcr: 154f
pscial: 4, wdtcr: 114f
pscval: o, wdtcr: 134f

| 4> [ ]\ Messages A Stdout /

% @2 HALTED

s R R AN RE IE IS AT Bl K, AT ki CCS 1 [ Debug)] - [Reset CPU],
SRIGEHT Load F/F . WIHESEANGE MRS AT sl R P Y, Wl T AR BRORMT B2 0T LA

S —  LED MOTSELe
XA 7 R GPIO,  HEI4%H] LED TAEMBIFE.
fERIS, 42 DU DT
(1) fiidi “cCS”, Ji5) Code Composer Studio JT & 55
(2) fiii [project] > [Open...]1 #IFF “5509GPI0” LA R “5509GPIO.PIT”.
(3) Jin#& “5509GPI0” 3L Ry “C5509.GEL” U On#k 7 vk WA TEIT L)
(4) riili [File]l > [Load Program...), #E#¢ “5509GPIO” X F1) “DEBUG”

thp) “5509GPIO.OUT” 04, iy [3THF ).

(5) i [Debug] > [Run] 57c R EEH 2 BIbR, 4odisdT. WEIF ki, B
" BT AL 8 A4 LED #8i N 5%
T AR IR AN RE IR IS T BURE PR K, W] il CCS 1 [Debug] - [Reset CPU D,
SRJE HHT Load 27, WIAUE R AREIEMIEIT R P K, AT TT ARy IO AR J0T E

5280 = CPU Timer SENf2R5CL

XA A AE ] VC5509 5E I A5 17 o
FEFHI, % LL A ERIEAT
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(1) fiii “CCS”, Jish Code Composer Studio F & 455

(2) it [project] & [Open...1 $1FF “5509TIMER” SCA4EJ R “TIMER.PIT”,

(3) hn# “5509TIMER” SCAEJ2 R “C5509.GEL” S CNg ik WA E 7 3L K8

9]

(4) il [File] & [Load Program...), 3£ “S509TIMER” (4432 R ) “DEBUG”

HHF “TIMER.OUT” X0, dids T4T9F )

(5) smitdi [Debug] > [Run] S7c R HEH 2 KlbR, 4idlisqiT. WEITAMG RN
AR BT AR LI D3 U NS, EosE i da e .

‘% /C5509 TDSSLOUSE 2.0 Emulator/CPU_1 — TES320C55zx — Code Composer Studio — [timer.

0511& Edit View Projeet Debug GEL Option Profile Tools DSP/BIOS Yindow Help

A& HE By @ | jﬁﬁ“ﬁh‘%%-‘.? & K | 4=+ | uE g = 4
[timer. pjt ~|[pebug -l & @& L)
Hléa OEERERHEA
§ Files ZI
r g ﬁEL.f]tES F Feferencs Start of Jntersupt vector tadde *.
- é”l elc_:r it (ebu o Tkis symbal is defised In File, veciars.sS55 *
Dnepﬁem Pm_e' extern void VECSTART (void):
Documents
) #define TIMER_CTRL TIMER TCR_RME (™
825” T e TIMER_TCF_IDLEEN_DEFAULT, % JJLEEW == & N\
. DI“‘I‘”: ed Fries TIMER_TCR_FUNC_OF (1) . o S 7N
: DL“: e TIMER_TCF_TLB_RESET, w TLH TN
La S‘ raries TIMER_TCR_SOFT_BREPTHOW, o ST AN
“‘;“.e TIMER_TCR_FREE_WITHSOFT, R AN
4 "“‘Z” £ - TIMER_TCR_PWID_OF (0], o DTS AN
@ e e d TIMER_TCF_ARB_RESET, o GRE TN
| timer. en TIMER_TCR_TSS_START., o TS a7 oE N
TIMER_TCR_CP_PULSE, R 7N
= TIMER_TCR_POLAR_LOW, w« FOLAR ZEEYAN
TIMER_TCR_DATOUT 0 w AT RN
=) )
=
&1 ® reste & FIMER configuraiion stracture that oon be passed *-
E‘ w o TUMER confiz OFF funciion for fniiisiizsiion af Tiwmer *7
E cap el regrsters.
TIMER Config timCfgl = {
TIMER_CTRL, o TURE
0x3400u, T
0=0000 o RS
L
< »
[ |4 1 : ,J
[“T* TV T Messages p, Stdout 4 Find in Files K 3
h @ |[RUHNIHG File: C:\550845509Timer timer, o Ln 1, Col 1

T R AR AN RE IR IS T B PR K, W] iy CCS 1 [Debug] - [Reset CPUD,
IRJE EOHT Load 27, WIAUE R AREIEMIEITERE PR K, AT TT A0y A J0T L

XA T ] VC5509 RTC K61 FE .

S

R, 2L P BR kAT

(1) fiii “CCS”, Jish Code Composer Studio F & 45

S B B S
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(2) fiii [project] = [Open...]1 F1FF “5509RTC” I R “RTC.PIT”,
(3) MZX “5509RTC” CAEIE R “C5509.GEL” U Chnk J7 i WA & 1L (e )
(4) fiidi [File]l & [Load Program...), 3£ “S509RTC” F32 F i) “DEBUG”

) “RTC.OUT” X, i [#HT9F).

(5) ili [Debug] 2> [Run) B HebEfE ‘& Klbr, 4Hiztt. S5 — 085G,
RTC =4z, BIAIfE CCS R 7RI Al & 2 an F 0% 5 B, F£o8 RTC s fEIEH .

Periodic interrupt at: 1::4::59

RTC - testing a combination of update and pericdic interrupts - successful

[ 4] > [\ Messages }, Stdout A Find in Files / K

Y w0 [RumTNG

T AR AN BE IEMIS AT BUR PR K, W] il CCS 1 [Debug] - [Reset CPU D,
SRJE BT Load F27. WIAUE R AREIEMIEAT ERE PR K, AT TTABO 07 U AR J0T L

SERFH AD HiER

AT AT vCS5509 I AD [fifsilFE.

A, AN P ERIEAT

(1) il “cCS”, Jish Code Composer Studio JT /& 35

(2) s [project] > [Open...]1 #1JF “AD” T “AD.PIT”,

(3) & “AD” X T “C5509.GEL” S0 Cn#gr ik WA IF 3k i id)

(4) il File]> [Load Program...), ##“ AD 73032 F (“DEBUG " #)“ AD.OUT”
SCfF, Rl L

(5) {F“break point”4b 15 & s

(6) it [Debug) > [Rund =2 bofde g ,3: K¥g, 4#isir. £ “MAIN.C”
S, $RF“nADCO” B “nADC1 7, sy SbR A B, ZEHH 1R fr S s ik B L Add to Watch

Window), 41 FEIFTR.
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ey
while [ 1 )

1
for ( 1=0;1<{Z56;1++ ]

ADCCTL=02B8000; o Shdntsss, &0
do

wWork=ADCDATA;
} while [ uWork&Oxz8000 );

nADﬂ‘in e TP 3% JOUURL T i PN Bl
} Editor 4

for [ 1:

View Location of ndDICO

ADCH fdd to Watch Window 93%; Jgﬁ g
da Guick Hatch
1
Mixed Made
T wl
nADI
I Copy
asm( " ] Sk
Select A11

X, CCS A7 R 7R BL—A> “Watch” & 1, fEi% % H IR nADCO 5 nADCI
B RECT, W AD B ECy, R sl bR A B, 7E0 D B B b ik $E [ Refresh 1,
R n] SR A, B 20U ET AD FH SR g R . W N EIR .

FEASZR P, ol AATAERRCT /K J12 § R 7 1 8 J|IAZ 0 — 3.3v A LI (]
ICANBEREL 3.3v), JEMEE CCS % K AD F 5 E 41k

for ( i=0:1<Z56:;i++ ) z'
ADCCTL=0=8000; - SErilfEss, EEa0
dao
{
uWork=ADCDATA;
1 while { uWork&0z8000 j; Froperty Fage ...
nADCO[1]=uwWork&O=0££f; Yiew Location of [§]
1 Break When [8] is Read
for ( 1=0:;i<256:1i++ ) Break When [8] is Written
. _ E Add to Watch Window
‘zDCCTL=ngDDD; o SEhATEERE, EE T Quick Hateh
a
{

uwWork=ADCDATA;
} Whl].? ( uorkS&0=8000 ); Delete Selected Item(s)
naADC1[1]=uWork&O=0££1;

-
J 8dd Globals To Watch -I_‘
——— Add Tab. .. =
Eleme | Velue Edit Tab. .. =
= nADCO 0200004157 Delete Tab, L
& [0] &35 -
G [1] ]
@ [2] 42 Freeze Window
@ [3] 46
w [4] G449
@ [5] &50 v #llow Docking
w [B] 853 Cloze
@ [7] 554 Float In Main Windoew
@ [3] g58 unsign. .. | unsigne
@ [10] ] unsign. .. | unsigne
@ [11] g59 unsign. .. | unsigne
w [12] 453 unsign. .. | unsigne
& [13] GEO unsign. .. |unsigne -

Ln 37, Col 38
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e R KRG IERIS T e FE P K, w5l €CS H [Debug)] = [Reset CPUY,
SRJG BB Load FEF . WHRIEEARREIEMIS T o0 K, AT TR AR MRORMG 288 S L.

N ¥R SORAMIREXE
XA AAT ] VC5509 4h SDRAM [ 2
fERIS, 42U DT

(1) i “CcCS”, J33h Code Composer Studio JT 7 115

(2) Al [project] = [Open...1 1 FF “5509EMIF” SCA4-J2 R “EMIFPIT”,
(3) n# “AD” CAEYE R “C5509.GEL” U4 Chn#i v A =5 I3k (i i)

(4) fiiti [File]l > [Load Program...), E# “5509EMIF” {49 F 1) “DEBUG”

i) “EMIE.OUT” cfF, i (47791 ).

(5) fiii [Debug)] > [Run) /el ‘& Elbr, 4HEiT. £ “MAIN.CY
A, $k310“ databuffer”, iy BUPR A B, ZEFRH I B Hrp AL Add to Watch Window ],

N E PR,

oA L O L TT — WO O LI ULL L e
datacount++

¥
it SR S 4 =
souraddr = (int *)0z40000;
datacount = 0;
while(souraddr<{deminaddr)
Editor
databuff

} ) YWiew Location of databuffer
while(1):;

#dd to Wateh Window

h

IR S S S S L St Buick Watch

* fogd of P—"F-‘F‘?'E Mixed Mode

b A O A O O O O A O A R

Copy

SR, CCS Mm-S WEE, FATRT LA 2 SDRAM BEHORK A, Wik

KR, 11K, FFEEARKNE, o)L SDRAM TAEIEH .
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databuffer | 0x0000800
& [0] ]
& [1]

@ [2] 2
@ [3] 3
@ [4] 4
@ [5] 5
@ [B] ]
& [7] T
@ [5] g
& [9] ]
@ [10] 10
@ [11] 11
@ [12] 12
& [13] 13

8o Wz Locsls 6% Wailch 1

Yoy oo [RAmTHG | | File: C:\G508%G509EMIFYemif. o

Figh, Ll [View] > [Memory] 85l CCS Ze M fy et Kl br » EFTIT

(AR A b, FLZ8 b5 B 35 “ Enter An address” [F1 48R higs AFRATINIA 5 N SDRAM
PR LEHLEE 040000, BIATE 2] 0x40000 55 AN A7tk i 8, W FER. AT LR
B, BN 1Bk, FEBAMAZ, AT WL SDRAM TAEIEH .
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VT

Nt

Ox00040000
Ox00040003
Ox00040002
Ox000400035
Ox0004000C
Ox0004000F
Ox00040012
Ox00040015
Ox00040018
Ox0004001E
Ox0004001E
Ox00040021
Ox00040024
Ox00040027
Ox00040020
Ox0004002D
Ox00040030
Ox00040033
Ox0004003¢8
Ox00040035

Mo oB

Ox0000
Ox0003
Ox000c
Ox0005
Ox000C
Ox000F
Ox0012
Ox0015
Ox0018
Ox001B
Ox001E
Ox0021
Ox00Z4
Ox0027
Ox00ZL
Ox00ZD
Ox0030
Ox0033
Ox003 e
Ox0035

]

j |E55EI'EI TOZ510USE 2.0 Emtﬂ

Ox0001
Ox0004
Ox0007
Ox000R
Ox0000
Ox0010
Ox0013
Ox001lc
Ox0015
Ox001C
Ox001F
Ox00Z2
Ox00Z5
Ox00Z8
Ox00ZE
Ox00ZE
Ox0031
Ox0034
Ox0037
Ox003n

Ox0002
Ox0005
Ox0008
Ox000B
Ox000E
Ox0011
Ox0014
Ox0017
Ox001R
Ox001D
Ox0020
Ox0023
Ox00Z28
Ox0025
Ox002C
Ox0D0ZF
Ox0032
Ox0035
Ox0038
0x003E

r 3
F
-

1

W R IFEFANGE LI AT ol fE P&, 7] it CCS H [ Debug] - [Reset CPUY,
SRIGEHT Load F/¥ . WIHESEANGE MRS AT slFE P Y, WIS T AR BRORMT B2 0T LA

LB § R FLASH R 55EHR
ARSI WA A VCS509 525 AMFAT FLASH HIBIFE . JF4T FLASH 13 K [F AR Ik
JF 18 22 A LIRS P B0 F 4
AT, 4% DL P BRAEAT

(1) fiii “CCS”, Jish Code Composer Studio F & 45

(2) it [project] & [Open...] 1 FF “5509FLASH” SCAF3 ¥ “FLASH.PIT”,

(3) GWiFFET

(4) it [File]l >

] “FLASH.OUT” xxff, sidi [479F).
(5) NIAEARSLIROR, EE FEBTRN, F1 EAWS.

[Load Program...), #%# “FLASH” X3 R “DEBUG” H
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bl RS Ay AR RN

for(datacount=0;:datacount<{1000;datacount++)

{

databuffer[datacount]=0;

l
@ Flash_CS():
fraddr = fwaddr:
for(datacount=0;datacount<{1000;datacount++)

1
databuffer|[datacount] = Flash_Read(datacount):

T
Flash_disCS{};

SAE AT B, FE v ew- —mamoniE B A da tabuF ar F g It TR,
@ while(1):]

B e L L T E e

JAE “MAIN.C” Xfrh, 43 “databuffer”, Ui ARG EE, ZEFRHII R g srpik
£ [ Add to Watch Window], Uit “databuffer” Fi2xis BN AL N A KM EAEY (KREEEIFES

% AT

(6) fiili [Debug] > [Run) oA M Pesi ’2 Kbr, S#iaiT. YREFIsiTEE
— /NS, SRR ZR A, W TR MR IR FLASH BEdEEEC ek, H
“databuffer” C2EEZE.

et e R e A L e S 3 T
for{datacount=0;datacount{1000;:;datacount+

d
databutfer[datacount]=0;
}
& Flash CS();

fraddr = fwaddr;
for{datacount=0;datacount{l1000;datacount+

{
¥

— - - - rurm o

databuffer[datacount] = Flash Readda-

“databuffer” W] AYEMEAEFAEL, a1 N PR,
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Hame Yalue Tyvpe | Rad: *|
W datacount 1000 urn. . un. .
- E? databuffer Oz0000&8005 un. . hex
& [0] 0 un. .. | un
& [1] 1] un. .. | um.
9 [2] 1] un. .. | un
g [3] 1] un. .. | um.
W [4] 0 un. .. | un.
i [5] 0 un. .. | un
& [B] 1] un. .. | unm. .
o [T] 0 un. .. |un. . ¥
,%: Waich Locgls o%” Waich 1 |

S, PV [Debug] > [Rund sk /et R S v
B3 AW, B FIEA . W FEFUR. B R FLASH SR80 O 56

L

databuffer[datacount] = Flash_Read (datacow
¥
Flash_disCS():;
A E AT B A, FE VI ew— —memoriE S A databuf feriFi
& while(1);
i I-I-
A FLASH B2 Ml , v M SHED WA “ databuffer”, @I~ B, K,
“databuffer” [HRIE 8, 75 GHATRR BB, IEWIIFT FLASH MRS 2 il

i o

Hame Value

@ datacount 1000 c..jun. .
- & databuffer Q00006005
(0]
[1]
[2]
[5]
[4]
[5]
[&]
[7]
[5]
9]

rn n
Boowzon Locs A Watch 1

|_]
|
o
]
i
o
k

EEEEEEEEEEEHS

EEEEEEEEEE

D D D D D D DD D D
el L =R R R S VR

3
3
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T AR BB FLASH 17 REL BT BOREE 148, Al ATl
i B QM2 AT . W ML R s

upg BRSPS I TR R A T A=
PLL config(&myConfig):

T HSA DSTERT o S8 SR G A e
EMIF config(&emiffig):

Flash_Reset():

ik Aoy 2 Tasld G TEVRT A, B SiTIREEER Y

SUCCess Flash Erase  alli):

wrlnd PR I ELAMP AL R0

Flash _Write init():

fwaddr = (int *)CESECTL: .8 if B 2h 15 5095008127 ¢ Aol Vannse i )
fwaddr += 0xz10000; g AT S VT TR

faridatarcont=l datarnant< 1NN -dataronnt+4+0

W R R P ANBE IEMIS AT BRI %, ] ity CCS ' [Debug] > [Reset CPU L,
SRJG T BT Load 2)7. WAL SEARE IEMISAT BRI H K, WIS TR RARORN; B35 F 8 b Ha

Sz )\ PR E A M2 # (FFT) 256

ARSI AE ] VC5509 HEAT FFT BB, FFT A REIRARES % “H9 5 R
G2 CHPAR AL AL EE . ARSI S A EE R

A, 4% LR PRI T

(1) fiili “cCS”, Ji5) Code Composer Studio JT & 55

(2) siili [project] - [Open...Y FTJF “FFT” XA T “FFT.PIT”,

(3) GiiFRE.

(4) 55 [File] > [Load Program...], #%#¢ “FFT” C/FJ T “DEBUG” H()
“FFT.OUT” 3Cff, riddi LF17F)s

(5) fiidi [View] > [Graph] 2> [Time/Frequency), FTFMELE L1, #4741 N &I

ANBEE, RE A TOKY. Wi M s i AE, i [NOY Biny.
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E2 Graph Property Dialog

Display Type Single Time

Graph Title Test Wave

Start Addreszs INFUT

FPage DATA

Acquisition Buffer Size 128

Index Incrament i

Dizsplay Data Size 128

ISP Data Type 16-bit signed integer li

Cancl | _ielp |

B Graph Property Dialog

3 Single Time
Graph Title FFT
[Start Address DATA
| Page DATA

| Acquisition Buffer Size B4

| Index Increment 1

{Display Data Size 54

| DSF Data Type 18=bat signed integer

(6) BRI R, AU ot 1 B o, ey bR A8, ZEFE SR S rp “ Clecar

Display”.
Zoom Out 3 PR — -
v Axes el E' [z|
] v Status Bar
388 Grid *
1 Curzor Mode L4
ZTTB-: Log Scale
] Fixed Scale
165?? Refresh
E-Eﬁ:—:
— Clear Display
_E.Eﬁ:—: Help
| Properties. ..
—165?—:
—ZT?B-: Close
] v Float In Main Window
-3880
_l-.l:”:”:l_:""I""I""I""I""I""I""I""
0 18.0 320 43.0 64.0 20.0 96.0 112 127
(B3, 01 IHFUT Time Lin Auto Scale

(7) BB EFEP I “FFT.CY WA TR “break point™ [R5 B BB AT A
(8) IBATIF ML LR
A, ZEF “Debug” ZHAP) “ Animate”, % F12 BT T
B, 15 “FFT” BB 1 h sl 4 8, 1B FEJE 4 Display Type %44 FFT Magnitude
24 & FFT Magnitude and Phase, 5 2§%E W78k FET. M8 K .
C. W% “FFT” WL L s %
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D. MEEEIEE L H CCS THEH IESZ P FFT. W FE PR,

= Test Wave
512 1 Bevd]
0] B
.5125 v \_/ v ) IEB'HE
-1m:l T T 1 -3 SM:I ¥ T 1
1] 320 540 9610 12 1] 155 30 46.5 s2.0
{53, 150) [Time Lin |Auto Scale | |[t31, 4) Time Lin* [Auto Scale |

{0,246094, 159,103 [FFT Mag Lin Jauto 5cale R

0 AR P AN GE IE RIS AT BB P %, mf siedy CCS [ Debug) - [Reset CPU,
SR )G HEFT Load F2)7. WAL SR ANRE IEMISAT BRI K, w45 ARGy B35 J8T b i

LR FIR S8 28LR
ARSI WA ] VC5509 #EAT FIR JEBEASHOBIRE . FIR JEEAAT AR AINIES
% AT HRGE” BT TRIL” G BEE . ARSI A LR
A, 4% LR BRI T
(1) fiii “CcCS”, F3h Code Composer Studio JT & ¥4
(2> siili [project] - [Open...]1 FTJT “FIR” CAEJC ) “FIR.PIT”.
(3) A7 [File]l > [Load Program...), #E# “FIR 3 fF F ) “DEBUG” H[)

“FIR.OUT” fF, riihi [477F)s
(4> i [View] = [Graph] = [Time/Frequencyl , FTFW %% 10, FEAT00 T BT

AR, XA Rid [OK].
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I Graph Property Dialog | El

Dual Time -
Graph Title Graphical Dizplay —
Interleaved Data Sources Fa
Start Addreszsz - upper displ &fInput
Start Address - lower displ &f0utput
Fage DATA
Aequisition Buffer Size 1
Index Increment 1
Digplay Data S1ze 128
DEF Data Type 32-bit floating point
Sampling Rate (Hz) 1
Flot Data From Left to Right T
Left-shifted Data Dizsplay Yes
Autoscale On
IC ¥alue o
Axes Display On LI

0k | Cancel | help |

(7) WEW A AEFRT SO “FIR.C” AT VERE “break point™ 11 A b1k B T A
(8) IBATIF ML LA
A. % “Debug” FZHAK “Animate”, Bf% F12 #I1TFE T
B. W%¢ “INPUT” “OUTPUT” WJEH H KIS T, S 08 BOR «
C. 7& “INPUT” “OUTPUT” I % Hrh sichiArd, EHEME, HlEE RN
FFT. WSS ETE .

D. M%< “INPUT” “OUTPUT” % LI ASEL K K . i R IKI AT
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111

NAANAN

0173

-0.30
-0 516

i

-1.411

Y
3 /)

Dfﬁ-

WLV VYVVY

0 3
tgg.usm:u:-;g ||714in [Time h.n Auto Scale |

e SRR AN RE IE IS AT B R P K, AT ki CCS 1 [ Debug)] - [Reset CPU],
SRIGEHT Load FE/F . WIHSESEANGE IEAISAT a2 P Y, W TF AR BRORMG B2 0T b

LR+ IIR BEARER

ARG R WG] VC5509 ZEAT TR JEREASHIRE. TR S8 a7 K0 HIR ARG 2
% MRS HRGR” BTG FELAEE . ARSI R AU FLSE

A, AN BRI T

(1) i “cCS”, Jish Code Composer Studio JT /& ¥4

(2) sidi [project] > [Open...1 #JJF “IIR” AR “IRPIT”,

(3) G iR,

(4) 455 [File]l > [Load Program...), #E#¢ “FIR” XfFJ R “DEBUG” H[1)
“IIR.OUT” A, s [F1F )

(5) siidi [View] > [Graph] - [Time/Frequency), FTIFMIEEH 11, AT R P

AR, AE s [OK]
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E® Graph Property Dialog | x|

T

Dual Time -
Graph Title Graphical Display i
Interleaved Data Sources .
Start Addres= - upper displ &fInput
Start Address - lower displ &f0utput
Fage DATA
Acquisition Buffer Size 1
Index Increment |
Display Data Size 126
DEF Data Type 32-bit floating point
Sampling Rate (Hz) |
Flot Data From Left to Right F
Left-shifted Data Display (YTes=
Autoscale On
DIC ¥Yalue 0
fAxes Display On j

0K | Camcel | Help |
(6) BEW A ERFfF “IR.C” AR “break point” [¥)7EA) ik B H it
(7) BATHMEREE R
A, JEF “Debug” ZEHA] “Animate”, % F12 BIZ1TRT

B. WM& “IIR” PILE LKL, WEIEBAECR .

T
DEET
0550
01274 A M \

=027

-0

<114
0.235]

0183
01314
0.0783]
0,021
00261
00783
0134
nAE]
-0y

o 107 23 =0 a7 533 540 47 853 =0 07 "y 1z
(63, 0,745296) (E3, 0. 126796) [Time Lin [ Scale |

T AR AN RE IE IS T B PR K, W] iy CCS 1 [Debug] - [Reset CPU D,
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SRJEHHT Load 27, WIAUE R AREIEMIEIT R PR K, AT TT A0y LA JE0T L

LR+— BHEMNIBEA (FIRLMS) LK

ARSI WATATH] VC5509 1E4T FIRLMS U8 #9175 - FIRLMS S8 A7 5% 1 B8
FPNESE “A5 55 RE” RS TR . ARSI AR E i B

AT, DA B BRI T

(1) i “CcCS”, J33h Code Composer Studio JT 7 11

(2) mifi [project] & [Open...]1 77F “FIRLMS” SCAFJ 1) “FIRLMS.PIT”,

(3) fiidi [File]l > [Load Program...), #%# “FIRLMS” (3 N “DEBUG”
Hiff) “FIRLMS.OUT” 3¢, il [4TIF)s

(4) Aili [View] > [Graph]l = [Time/Frequency), #TIFMLELE 11, #EATU0 NPT

NBE, A Ridr TOK].

E® Graph Property Dialog ﬂ
[Display Type  [IESIETTION =

Graph Title Graphical Display

Interleaved Data Sources Ha

Start Address - upper displ xx

Start Address - lower displ rr

FPage DATA

Aequisition Buffer Size 1024

Index Increment 1

Display Data Size 1024

DSF Data Type 16-b1t =1zned integer

B-wvalue ] —
Sampling Rate (Hz) 1

Flot Data From Left to Bight

Left-shifted Data Display Yes

Autoscale On

IC Value 0 ol

0K | Cancel | Help |

(5) IBATIHMEEGIR, LERER TR RAL i 2
AL ZEF “Debug” EHRH) “ Animate”, B F12 $I21THE)T
B. YFEFIs T LG, WS “IR” PR E DY BoRgs 2.
C. %F 1 [File] > [workspace] > [save workspace As), A A4 SY.wks.
AR, N E PR
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W JC 8 S Funetinnal Smu

Dk e LU - C8 50w (Saaulatior) - Conde Compaser SEudn

i8] %

Die [t West Projpct ety Proflr GRL Opton Took DEPRBICS  Wndes Help

RS oo oo ﬂﬁﬁh%&ﬂ“ﬂhﬂﬂiit%1$f|
framas. g5 =\ B EET AR '%|
mw'uamm@li[

Ll I

T ) GEL Bl
o ||| 50 Prokects ot
1 & TBRLMS it Rehug]
f]l_ | Depencierd: Project
[ SREIES Config
i =) Gerrated Pz

7 irehsda

A=A Emr 1 AR
I Euibiibin) v LYY

B

.' [T, a7y EL, 4T ITmusu- |
= =10
o -10] x|
) 26
&1
2
10 '
A0
<0
-5
"I _"I -411 - . _ . . I . . - . .
- [ L] im Eecd M1 Lo w3 JEr (k] TH =] ] M
o B T T ko s |
TG [ For ek, press FI Dz can [ [ [

e W RPN e IEAIS AT e R P K, Tk CCS H [ Debug] = [Reset CPU Y,
SRJGFLH Load FEI7 . WHRIE EANREIEMSITolRE i &, T TR AR MORM B3 T b,

LH+Z fEAHELE

ARSI S QA A TR AR L 4 AN SR IR

R, $BL NP RREEA T

(1) fiili “CcCS”, Fi3h Code Composer Studio JT /& ¥4

(2) s [project] = [Open...Y #TFF “5509BUTTON” ST Af KT [ “ EMIF_
BUTTON.PJT”.

(3) GaiFfRIT

(4) fiihi [File]l > [Load Program...), i#%#% “5509BUTTON” {432 F ) “DEBUG”

Hiff) “EMIF_BUTTON.OUT” CfF, fidi [419F).

(5) riili [Debugl > [Run] =/ Pt 2 Kbz, 4udizfr. THIFAR KL,
K2. K3 8 K4 %8, £ CCS FHHfs BEAEH IR E S| “KI1 presss” Z FRHHERNIE, $nit
ML CHAE T . W N EPR:
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k1l domw
: | )

~eeeian Kl

£
5 A .

El press
EZ press
E3 press
Ed press
El press
E3 press
EZ press
El press

| <] »[» [\ Messages A Stdout /
¢ @ RUNNING

s W R IR ANGE LA AT ol RE P %, 7T s CCS 7 [Debug] = [Reset CPU],
SRIGEHT Load F/F . WIHSESEANGE IEAISAT a2 P Y, Wl TF AR ARORMT B2 0T b

Eh+= SEP A KR
AN S U AT A I R A B A e T R
AR, $BL NP BREAT
(1) il “cCS”, Ji3h Code Composer Studio JT & ¥4
(2) A [project] > [Open...Y F1JF “5509EXINT” {3 i) “EXINT.PIT”.
(3) fithi [File]l > [Load Program...], 3 “5509 EXINT” X {3 R i) “DEBUG”

hff) “EXINT.OUT” 0, sidi (47T ).

(4> riili [Debug) > [Run] =¢/: M HRAERE 2 Kby, adiafr. TP Ekeys
fekt, 76 CCS T MfE BAE T RIW A F] “EXINT ouccers” $#&751H, H#7mixshl b g™
Ao W KPR
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e
| Dl

EXINT ouccers
EXINT ouccers
EXINT ouccers
EXINT ouccers
EXINT ouccers

| <[ »[» [\ Messages A Stdout /
g = RUNNING

e W R IR P ANBE IEMIS AT SR %, ] iy CCS # [Debugl - [Reset CPU L,
SRJGHHT Load F2)7. WIS R ANGEIEAISAT BP0 &, w25 TR AR BORI; B8 T8

FR+P0 AIC23 BELL
ARSI IE WA ] VC5509 $551Hi AIC23B, & HY B4 5 5 (1 i 72
AN, $UA R AR
(1) fiii “cCS”, J3h Code Composer Studio T #4
(2) giiti [project] > [Open...]1 #JFF “5509COEDC” LI FI#) “CODEC.PIT”.
(3) GiiFRE.
(4) riidi [File] > [Load Program...), E#¢ “5509COEDC” X4 F ¥ “DEBUG”

i) “COEDC.OUT” A, s [4TT).

(5) fitdi [Debug) > [Run) u /A= bl ‘3 Kb, HGEAT. B HHUE AT RAR
I “PHONE” 4Ly, mtRENT 2 AL A HI R

T RIS RE IR IS T B PR K, W] iy CCS 1 [Debug] - [Reset CPU D,

SRJEEOHT Load 7. WIAUE R ARE ST R PR K, AT TT AR 07 JC AR J0T L



7%{%‘#33 5 http:/www.mcuhx.com TEL:028-84779619 QQ:601105013

$R+H LCD BRER

XA S AT 5 TR R AR LCD /s U IR L

By EHLAT, 1556 LCD i bo AREFAEA T IR ) DM12864M Wi,
HAB S LCD 3 1947 58 R

AR, 42 UU N P BRIEAT

(1) il “cCS”, Ji3h Code Composer Studio JT /& 345

(2) gty [project] > [Open...Y1 $1JF “5509LCD” A F ) “LCD.PIT”,

(3) In#& “5509LCD” CAEIE R “C5509.GEL” U OndkJrik WA R TF L IiE k)

(4) iidi [File] > [Load Program...), #E# “5509LCD” {3 R “DEBUG”
Hiff) “LCD.OUT” 3CfF, riidi (4177 ).

(5) st [Debug) > [Run Y s A bl 2 Blbs, AHIEAT. WEIF R I LCD,
ISR B s =

W R IR P ANBE IEAIS AT BRI K, v] fiihy CCS H I Debugl>[Reset CPU],
SRJGFEHT Load F)% . WAL R ANRE IEMISAT BB P K, T4 TR R BRI 028 Fr L

L+ BOEFER

XA an e 45 FH R AR F 1Y) RS232 #5115 PC Jd iR IF 51l

B R, T SCIEARE A 9 BFHR LR (EELD L.

AR, $UL NP BRIEAT

(1) il “cCS”, J33h Code Composer Studio JT /& ¥

(2) A [project] > [Open...Y 17T “5509UART” 13 R “UART.PIT”.

(3) Jn#& “5509 UART” U R “C5509.GEL” SCAF C# s i AR TEFF 3L K18
)

(4) #5iti [File] > [Load Program...), £ “5509 UART” L3 R “DEBUG”

i) “UART.OUT” XX, i [T ).

(5) Aili [Debug] = [Run] s/c bt 2 ElbR, AHET.
(6) #TIF “H Lk T LAl DS TR, KSEE N “19200bps.

P ol A AN V{61 VAN W VA o (o VA (Y SR v RIS sk TN o/ SRl @20 P
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RURTAE “HRSZHE” TR BN TF R MAL IR — B — R . W R IR,
HIELE R (CEREERRE W30 00

— e
:ﬂjj . ?ﬁ_ BaramEhEba @9
w1200 v
Hragfor |[MOME -
iR A v
wikf it =

@ a4

BT B

- BT R
[+l ET
- HEEEER
BENE ERET
FEEBE

- BEEERES
C EREEHET
- bR
T iR ERER

55 AR 1000 =R | |8 ]
2 e B
L& FhEEl FiE 9 fi 48 Bty

T AR AN RE IR IS T BURE PR K, W] iy CCS 1 [Debug] - [Reset CPU D,
SRJEHHT Load 27, WIAUE R AREIEMISIT R PR K, AT TTARBO 07 LA JE0T E

£+t USB2.0 EfsLk
XA A VC5509 o USBI1.1 #2115 PC ALE W1 B
fERIS, 42U DT
(1) i “CCS”, J33h Code Composer Studio Ff & I8
(2) #iifi [project] = [Open... Y #1FF “5509USB” U432 R i) “DSK5509 USB.PIT”,
(3) Jn#k “5509USB” SCAFJE R “C5509.GEL” SCAF I 7 ik WA T TRk i)
(4> piidi [File]l & [Load Program...), E#¢ “5509USB” SCF3 R “DEBUG”

Hf) “DSK5509 USB OUT” CfF, iy [41F]).

(5) giili [Debugl > [Runl =M EERE 3 Klbr, 4diztr. S/ USB &
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K2 R USB B A 15 Huligift) USB [, BRI, Windows 47 F st it LR ILE
fErEY, W N RN,

i EWEE
USE Dewvice

# /05509 TDSSI0USE. .

AN R EPs K CREGH ORI T 1 XA, 20 ERER e [, B A
(DY, Rt [F—2 L

BATNEHRS
B B FTRE [A5

.hil\
g !
Yindows FIEATETEHL. IEHEEE CD & Windows

Wpdate FiS (L ILFRIISIL F). L 20k sk g AT
RO
Y

Windews A LLZEIEF] Windows Update |2 IS iy
O, -k

O 2 TR EER ST E)
@&, EEF

#it T—5" B4,

2w [ mE |

BT S, 1 DASIERSR e E 228 (mgo), sl UF—2 1
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A B P E S

3
2 SR

USE Dewice

() mMPEMEETEEE ) R, FNEE
i HEA.

EREEFM A
O BehaRni (#5F) (1)
@ s Bt (mEh) 5]

Zéte, R E CT—F" .

KE—#®|[Ff-2%w> [ W& |

Pl Fm, R (EMR P RRRIEAMIEY e sd LR, AEsf i screk
HFEHES, R ADEHET ) LCUSB_driver] SO, sl D), #aih UF—

£

WEEEARENEERE..
MR B A R A B IR R e e
(O eI E PSR EIRRNIRRF (5).
EHTARMSIRER R T BRI 8% , BRENRETNA SR, a5 () eesd 1 G
2R EE=hiE . # [5) ecs3.3
Cleesamshidis G, co-kon.. ) @ = eesi t_driver
% (25 DSPICE-USE2
ERFPAHIE Q: =
F:hcos3_1_driver'USB_driver v % [ DSKS509_USE
3 1in
4 OFEHF. BFOCEEERRBABEENER 0). P = : 5 ¥
H: MESRIZ T 2L (28 M PRe chise 240 S IREhTE R Windows -TRE(RIEEATIEZAYIH
i =iz SIERE R LD
EEEEAFILME, F8E LT + S.
il

1 [r—sw|[Fftw>] [ BE ] |

B Fim,  QRAT Qe S, sty D8R 2]
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BHFWBE S
SRR ., G, .. .

% SEED Embedded DSF Controller

— IETE A A A SR -
. SEED Embedded DSF Controller

RHIE Yindows EHFEEL » LERIEER] Windows XP
HFRE . MJ

EETE NS VR LR RS SR
Nicrosoft SRBEMALILILEE , R
BEE, LEEEiEE Tindows Hbwlliliictf.

[ nAEE o

] | |

T2 RN e IR SR 2k, BN S, s 5epd BET
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+5 3 3 1) el 5

T FH S
N 1ZE RS T TRE SRS

% SEED Embedded DSF Controller

ZRBIEF  15EE TR .

W) “USBDEMO.exe”, FIFFJEU1 T E 7R, siidi [Scan for USB Devicel,
B A8 —A 7 USB #% [decusb-01, FiZ EAZHURERS, BEIArscdigr Aty PC il USB
KA
7. USBDENO X

dewice l]:lescriptnrs ] Pipes ] Class or ¥endor Request]

Avallable Devices

Sean for USE Dewice |

Open Cloze

Current ¥ersion

1.0

www. seeddsp. com

futput Window Clear Output Window | Cancel
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VE: W RIFE P AL IEMIa T el Ml K, ] i CCS ' [Debug] = [Reset CPU],

SR HHT Load 127

lﬁ’fT ?7&@\\ ﬁﬁ: i«%ﬁ

Rk &

ABEIERIE

L+ /\

RIS, 3% BL N BRI T
(1) giddi “ccs”,

ATERRE I, TS T AR A FEORT A

ZE ST

XA TR U B V5509 Jlid 8019 SZER LI MIIE TH 11 FE

FBORDEAL_ L) SPYNET A

JA 8)) Code Composer Studio JT & 5%

(2) giii [project] = [Open...1 FTFF “5509IP” CAJ& R “IP.PIT”,

(3) fiddi [File] >

1 “1IP.OUT” X, miidy [4T9F).

(4) 4T7F SPYNET /) CAPUTERNET %At (47T

[Load Program...), iE#¢ “5509IP” (43 FH) “DEBUG” H

A3 CITA R Y ). Jf

R4 B R SE bR R T IR B . W SEEE S, i [Start Caputer], JFLAMEALLAA N
B L.
(5) WE MK IP Hillk ok “192.168.1.40”

(6) fiili cCS H [Debugl = [Run) oA i Hefdeg ‘3 Kbr, Iz T,
(7) W% SPYNET SRIN & HE . X & —A> ARP i KL IP SR hE 5 £

N E PR

Ha.

| Time (him. ..

|MAE source addr

||F...| Frotocol

Addr. IF sre | Addr. IF ... | For.

BrhaEN e, 26—

16:42:1:1T1 0Z2-E0-4C-A0-TE-TA ARF  ARP-Request 192.165.1.11 192 1658.1.40
1 16:42:1:171 AO-1T-45-32-TD-TE ARF  ARP-Reply 192.163.1.40 192 163.1.11 -——-
£
oooo: FF FF FF FF FF FF 02 E0O 4C A0 7E 7A 08 06 00 D1 ........ |
0010: O8 00 06 D4 OO0 01 02 EO 4C AD 7E 7TA CO AB 01 OB ........ [l bt bt
0020: OO0 OO0 OO OO OO OO0 CO A3 01 28 00 OD OO OO OO DD ......... (e
0030: OO0 00 OO OD OO OO0 OO OO OO0 OO OO OD cieeenannnss

ANt ARP K, TP RARCR A s 55 =42 ARP [FAY,
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7 R R 2 45 T AR o
VE: AR IR ANRE IEIf IS AT SR P B §, 7T Rdili CCS FPlDebug]->[Reset CPU Y,
SRJE HOHT Load 7. WIAUEZ AREIEMIEAT SR P K, AT4TT AN (1 A Z08T E AL

R+ MMC/SD RiEE LR

AT AT ] VC5509 1 MeBSP 25 MMC/SD R Il

MR, $BL NP RRIEAT

(1) il “cCS”, J3sh Code Composer Studio JT & 315

(2) A [project] > [Open...Y FJJF “5509MMC” A3 F ) “MMC.PIT”,

(3) Iz “5509MMC” SCHEIE R “C5509.GEL” SCA ARy i WA 55 FF 3k K118
)

(4) giili [File] > [Load Program...), E# “5509MMC” IR “DEBUG”

i “MMC.OUT” oA, A [#JF )

(5) fiidi [Debugl = [Run) ol A ) He s ‘& KR, 2Hiztr. BT EF CCS
FOTHEP HrH MMC 2% SD RIS R . W R 2 B TR .

A, WERYE, &% “Initialized card successfully” “TEST PASSED” “F4f, Ul

A TR

= —— readBlLen =9
ggccgigtggiisr setup test... readBlPartial -1
Ehilgalues in Eh§5§ID of the 3D card are: gg;gg?iﬁ?;i?};gn z g
e -5 dsrImp -0
FurRes -7 cSize = 3843
seriallio - 16445 ddRCursiin =7
— - 10 vddRCurqux =B
vear — el dWCurrMin =7
Asking SD card for its RCA... ngwcﬁriﬂax - 2
RCAE sent is Oxef2d colzeMult -
The walues in the CSD of the SD card are: eraseblkEn =1
csdStructure =10 sectoriize = 31
taac - ag wpdrptize = 127
nsac =0 wpirpEnable =1
tranSpeed = &0 riwFactor = 4
coo = 501 writeBlLen =9
readBlLen =9 writeBlPartial =0
readBlPartial =1 fileFmtGrp =0
writeBlkMisalign = 0 Copy =1
readBlkMisalign = 0 permwriteProtect = 00
dsrImp =0 tmpWriteProtect = 0
colze = 3843 fileFmt =10
wvddRECurrMin =7 e = 0x55
vddRECurrtazx = b Initialized card successfully
rrddWCurriin =7 TEST PASSED

[+ [T\ messages  stdout / K| ['\I'-.-lessages)\Stcloutﬁ

y @0 HALTED: =fw breakpoint y @0 HALTED: =/w breakpoint

VE: R AR AN BEIE IS T BURE PR K, W] iy CCS 1 [Debug] - [Reset CPU,
SRJF BT Load 7. WIAUE R ARE BT SR P K, ATETT AN (7 L s Z08T E R

T UESER 2 MMC/SD R B rig St sy, Scinsete, Wik MMC/SD RARESTIT, 1
R g e —x
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